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Multiframe 8.53 18 June 2003 
 Release Note 
This release note describes the Windows version 8.53 of Multiframe, Steel Designer and 
Section Maker. This release contains numerous enhancements to this range of software. 
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Multiframe 

The following features have been modified or added to Multiframe in this release. 
 

Generating Arcs 

An arc can now be generated within Multiframe by converting an existing member to a 
number of elements that represent the arc. This is done using the new Convert Member 
to Arc item in the Geometry menu. 

 
The original member, which defines the chord of the arc, is used to prescribed the 
geometry of the arc. The arc is generated in the local coordinate system of the member 
which provides a great deal of flexibility as the arc will be generated in a plane 
determined by the orientation of the original members.  

 
To define the geometry of the arc the user can choose to create the arc about the local y 
or z-axes of the member, specify the number of members used to represent the arc and 
the radius of the arc.  Alternatively, the radius need not be specified and the size of the 
arc defined by specifying the angle subtended by the arc or the height of the arc above 
the arc chord. 
 

Duplication 

Some enhancements have been incorporated into Multiframe to improve the 
functionality of the duplicate command.  The orientation of members is now preserved 
and will correctly reflect how the duplicated structure is transformed to its new position 
within the frame.  Furthermore, loads applied to members will also be correctly applied 
to the duplicated members. 
 
The full functionality of the duplicate command is now available when performing a 
cylindrical or spherical duplication.  This allows loads, restraints, masses, etc. to be 
duplicated along with the members. 
 

Mirror 

A selection within the frame can now be mirrored about a plane parallel to one of the 
global axes.  The user can also select to mirror the frame about a number of axes which 
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provides functionality to mirror a structure through a line or even a point. This command 
is accessed via the new Mirror item in the Geometry menu. 

 

 
 

Shear 

A command to shear the current selection has also been introduced into Multiframe.  In 
any 2D view of the frame, the selected members can be sheared in a direction parallel to 
the global axes by a user specified angle. 
 
This command is available using the new Shear item in the Geometry menu. 
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Reordering Load cases 

The order of load cases within a frame can now be rearranged via a new Reorder Load 
Cases dialog.  This dialog permits the order of load cases to be changed by simply 
dragging and dropping within a list of load cases. 

 
 

Maximum number of load cases 

The maximum number of load cases supported within Multiframe has been increased to 
500 cases. 
 

Load Case Classification 

Load cases can now be classified in terms of the type loading they contain.  As such load 
cases can be identified as containing loads due to dead or live loads, wind loads, 
earthquake loads, rainwater ponding, etc.  While this classification is currently only used 
for informational purposes, it will be used in the future within design codes that need to 
identify the origin of the loading. 

 
A load case can also be classified on the basis of its use in design.  This allows the load 
case to be identified as being used for the design of members for strength, serviceability, 
both strength and serviceability, or not used for design at all.  This classification of a 
load case is used to simplify the user interface by reducing the number of load cases 
listed in some of Multiframe’s design dialogs. 
 

Data export 

The export of results to the Spreadsheet text or Daystar formats now allows the user to 
select which load cases are to be exported.  
 

Sections Library 

The Australian, New Zealand and British sections libraries have been updated. New 
sections have been added to some of these libraries but most importantly, extra 
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properties have been added to many of the groups to specify the location of the centroid, 
shear centre and any fillet/toe/corner radii associated with a particular shape. 
 
The United Sates, Canadian and Japanese libraries are currently being updated and will 
be available in the near future. We welcome any feedback in regard to the content of the 
libraries so please advise us of any sections we may have overlooked. 
 

Modal Solver 

The user now has a choice of using either a Jacobi or Subspace Iteration solver when 
performing a modal analysis. 
 
As the Jacobi solver is a direct solver (i.e. not iterative) it tends to be more stable than 
the subspace iteration solver.  However, this solver is only suited to smaller structures, 
say less than 200 nodes, as its performance decays quadratically with the number of 
degrees of freedom required in the analysis. 
 
We recommend you use the Jacobi solver on smaller structures or any structures that 
have problems with convergence and use the Subspace solver on larger models. 
 

Mode Shapes 

The mode shapes resulting from a modal analysis are now listed in a separate Mode 
Shapes sub menu under the Case menu. 
 

Printing 

The Print dialog has been simplified by separating the printing of diagrams and the 
summary report.  
 

Wheel Mouse 

The graphical views in Multiframe can now be zoomed using the wheel on the mouse. 
The view in the current window can be zoomed in and out by simply moving the mouse 
wheel.  
 
Depressing the wheel button while rotating it will exaggerate the rate at which the view 
is changed. 
 

Synchronised Selections 

The selection in each of the graphical windows can now be linked such that selecting or 
deselecting an item in one window selects or deselects the item in the other graphical 
windows. 
 
The use of synchronised selections in optional, it can be activated or deactivated via the 
View tab in the Preferences dialog. By default, synchronisation of selections is not 
enabled. 
 

Acceleration Keys 

A number of new accelerator keys have been allocated or changed within Multiframe.  
The new key combinations are as follows 

• Ctrl+M  Mask to selection 
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• Ctrl+Shift+M Mask out selection 

• Ctrl+A  Select All 

• Ctrl+I  Add (insert) a new element 

 

Singly symmetric I sections 

Support has been added to Multiframe for singly symmetric I section shapes.  As part of 
this addition, the New Section and Edit Section dialogs have been reformatted so the 
standard section shapes supported within Multiframe are listed in a combo box. A 
diagram displaying the dimensions of the current shape has also been added to these 
dialogs.  
 

Joining Joints 

Joints located at the same position within a frame can occur from time to time.  To assist 
in eliminating nodes at the same position, a new command has been added that will 
merge nodes within the current selection that are located at the same position. The “Join 
Close Nodes” command can be accessed via the Geometry->Advanced sub menu. 
 
At analysis time, Multiframe will now check for joints that are close together.  If joints 
that are very close to one another are detected, the user will be prompted and given the 
option to join the joints before performing the analysis. 
 

Member Self Weight 

The self-weight of individual members can now be enabled or disabled in each of any 
self-weight load cases.  This facility has been introduced to allow the self-weight of 
different parts of the structure to be included in different load cases.  By default, member 
self-weight is included in all self-weight load cases. 
 
A member’s self weight can be activated or deactivated within a particular self weight 
load case or in all self weight cases by selecting the member in the Load Window and 
using the Load->Member Self Weight command. 

 
The Member Self Weight dialog now has an extra check box to allow the member self 
weight settings to be applied to all cases.  By un-checking this box, the member self 
weight can be included or ignored within the current load case. Other wise, if this box is 
checked, the settings in the dialog will be applied to all self weight load cases. 
 

Selection Rectangles 

The behaviour of the selection rectangle used within the graphical views has been 
enhanced.  If the selection rectangle is specified by dragging the cursor from left to right, 
only the members contained entirely within the rectangle will be selected.  However, if 
the selection rectangle is defined by dragging the mouse from right to left, all members 
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contained within or intersecting the selection rectangle will be selected. This provides a 
useful shortcut for selecting the members in the interior region of a frame. 
 

Load Dialogs 

The dialogs for adding loads to the structure have been improved so that the values 
entered in the dialogs will be restored next time the dialog is opened. 
 

Window Toolbar 

The current window can now be changed using a new Window tollbar. 

 
 

View Menu and Toolbar 

The views in the graphical windows can now be changed via the View menu. This menu 
has a View sub-menu that contains each of the standard views. The more common views 
can also be selected via the new View3D Toolbar. 

 
 

Licensing dialog 

The user interface for licensing steel design codes and non-linear analysis has now been 
incorporated into the preferences dialog. The menu items for activating or deactivating 
features within Multiframe have been removed. 
 

Expression Parser 

The equation parser used within Multiframe to interpret expressions within the Calc 
Window and in many of the dialog fields has been extended to support several extra 
functions. The new functions are as follows 

Max(x,y)  – Returns maximum value of x and y  
Min(x,y)  – Returns minimum value of x and y  
Atan2(x,y)  – Returns arctangent of x/y in the range from  -180° to +180°. 
Arctan2(x,y)  – Returns arctangent of x/y in the range from  -p° to + p °. 

 
 

Space Gass Files 

The import and export of Space Gass text files has been improved and a number of bugs 
eliminated. In addition, Space Gass Section Library files (*.slb) can now be opened 
within Multiframe by choosing the appropriate file extension from within the Open 
Sections Library command.  
 

Microstran Files 

The import and export of Microstran archive files has been enhanced and a number of 
bugs eliminated. The exchange of data has been extended to include the export of steel 
design data from Multiframe but this is limited by incompatibilities in how the two 
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programs store the design data and by the actual data stored within the archive file 
format.  
 
Microstran Section Library files (*.asw) can also be opened within Multiframe via the 
Open Sections Library command. 
 

Nonlinear Analysis 

The reporting from a nonlinear analysis has been improved and now prints a warning 
when the axial load in the member reaches a point at which the buckled shape of the 
member bifurcates from single to a double curvature mode. 
 
The reporting of the state of tension only and compression only members during an 
analysis has also been expanded. 
 

Steel Designer 

The following features have been modified or added to Steel Designer in this release. 
 

Installation 

The installation and licensing of Steel Designer has now changed so that you can choose 
which design code is installed. This is to allow for our releases later this year of design 
codes for other countries. You will need to purchase additional licenses if you wish to 
use more than one code. The only exception to this is Australian and New Zealand 
AS4100/NZS3404 codes that are bundled together. 
 
If you have a network copy protection device, you will have to run a utility, which we 
will supply to you, to update your dongle to work with the new licensing system. 
 

Printed Report 

Two tables have been added to the printed report that summarise the design properties of 
design members.  The first table is a generic table of design members that lists the 
members grouped to form the design member, it’s steel grade, yield strength, ultimate 
strength and its method of fabrication (i.e. hot rolled, welded, etc). 
 
The second table added to the report is specific to the current design code active within 
Multiframe. For each of the design members it summarises the parameters required to be 
input for the design of a member including effective length, stiffener spacing, area of 
holes, etc.  This table is very wide and will require output using a Landscape page 
orientation for best results. 
 

Design from all graphical views 

The design functionality within Multiframe has now been enabled in all of the graphical 
views of a frame.  Any of the commands in the Design menu can be used in the Frame, 
Load or Plot windows. 
 

LRFD 

Design to the AISC “Load and Resistance Factor Design Specification” is now 
supported by Steel Designer.  Full details of this code are contained within the Steel 
Designer manual.   
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This code does not yet fully support the design of unequal angle sections for flexure. Nor 
does the code support the design for flexure of slender sections not covered by Appendix 
F of LRFD. 
 

AS4100/NZS3404 

The definition of how a member is laterally restrained has been extended to provide 
more flexibility. As an alternative to specifying the location and type of lateral restraints, 
the member can now be specified as fully laterally restrained or the unbraced length of 
the member to be used in the design calculations can be specified directly. 

  
 
Some changes have also been made to improve the interpretation of lateral restraints and 
their conversion into segments. Furthermore, any member with lateral restraints defined 
at either end as unrestrained at both flanges will now be treated as a cantilever. 
 

Best Section 

Steel Designer computes the best section for a member when the user chooses to Design 
that member. The sections size of the member could later be updated to the best section 
prior to the frame been reanalysed. This mechanism has been extended to allow the user 
to specify the best section.  By doing so, the user can now select an appropriate section 
for a member without invalidating the results and requiring an analysis of the frame 
before the next member can be designed. 

 

Compression Dialog 

The effective length factors corresponding by the standard restraint icons are now 
dependent upon the current design code. The effective length factors now reflect the 
values specified within the codes.  
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Section Maker 

The following features have been modified or added to Section Maker in this release. 
 

Grouping 

Section Maker now supports the grouping of shapes within the Shape View. This allows 
shapes to be manipulated together as a single item.  This grouping is hierarchical so 
groups may also be grouped inside other groups. Shapes may be grouped or ungrouped 
using the “Group” and “Ungroup” commands in the Shape menu. 
 
When placing a section or shape within the Shape View, the basic shapes representing 
the section or shape will be grouped together as a single item.  When placing a section 
from a library, the group will store the name of the section and display this within the 
user interface. If, however, the shape is ungrouped, this information will be lost. 
 

Shape Properties 

The properties of the basic shapes used to model a section can now be accessed via a 
property dialog.  Double clicking on any shape will open a property dialog that contains 
the dimensions and location of the shape. This dialog may also be opened by selecting a 
shape and choosing the Properties menu command from the Exit menu or the Properties 
command from the right-click context sensitive menu. 

 
This dialog also lets you reposition shapes by specifying the location of an anchor point 
on the shape. This makes it easy to align shapes to other shapes within the section. 
 

Singly symmetric I sections 

Singly symmetric I sections are now supported within Section Maker. As part of this, the 
Place Shape and Group Info dialogs have been remodelled so that the section shape is 
now specified via a combo box. 
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This dialog has also been improved to allow the user to specify the material to be 
allocated to the new shape. 
 

Fillets and Toes 

The representation of standard section shapes supported within Section Maker has been 
improved with the addition of support for modelling toes and fillets of hot rolled 
sections.  This has improved the calculation of section properties so that the computed 
values compare very closely to values published by manufacturers.   

  
The radii of the fillet and toes are stored in new section property fields r1 and r2 that 
have been added to the sections library.  Many of our sections libraries have been 
updated to include this extra data. 
 
When placing a Section within the Shape View, the placed section will automatically be 
represented with fillets and toes if the appropriate fields describing the radii of these 
features are stored for the section.  If these fields have not be specified or contain a value 
less than or equal to zero, the fillet or toe will not be represented within the Shape View. 
 
Placing a standard section shape into the Shape View (see dialog above) allows the user 
to specify the radii of the fillet and/or the toes of flanges.  If a value of less than or equal 
to zero is specified then the standard shape will be added without modelling the fillets or 
toes. 
 

Undo / Redo 

All changes to the section being modelled in the Shape Window can now be undone and 
redone.  In fact, up to 20 changes made in this window can be undone and redone. 
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Improved dragging in Shape Window 

When dragging a control point (points that identify the extents of a selected shape) using 
the mouse, the control point will automatically be attracted to nearby control points of 
any unselected shapes.  
 
This also occurs when moving shapes using the mouse in which case the location of 
cursor will also be attracted to nearby control points of any unselected shapes. 
 

Shear Centres, Shear Areas and J 

While the calculation of most section properties by Section Maker is rigorous, the value 
of the torsion constant J is computed by summing the J of the shapes that represent the 
section.  This gives only an approximate estimate of J. An improved estimate of J is 
computed when Section Maker is able to identify the shape modelled in the Shape 
Window as one of the standard section shapes supported within the program.  Similarly, 
the shear area is accurately computed by identifying the section as one of the standard 
shapes. You should check the Shape field in the last row of the Properties window to see 
if Section Maker has been able to determine the shape correctly. 

 
In this release of Section Maker, the formulas for evaluating J for the standard section 
shapes have been improved and now make use of the fillet radii if this value is available.  
 
Using the same techniques, Section Maker is now able to estimate the location of the 
shear centres for the standard section shapes.  For sections that cannot be identified by 
Section Maker as one of the standard section shapes, the shear centre will default to the 
centroid of the shape.  Note that in this release the calculation of shear centres for 
Cee and Zed sections are not correctly accounting for the size of the lip. 
 

Adding Fields 

The layout of the Add Field dialog has changed to simplify the addition of fields to a 
group.  The Add Fields command now adds only a single field to the current group being 
viewed within Section Maker.  However, the user is able to specify the name, units and 
section properties associated with the new field. In doing so, the correct unit factor will 
be associated with the field.  
 
The flexibility of being able to add multiple fields via the Add Fields dialog has not been 
lost.  This can still be done by directly setting the number of fields in the Group Info 
dialog.  Furthermore, units not supported directly within Section Maker can still be used 
by setting the units name and factor manually in the Group window. 
 

Selection Rectangles 

The behaviour of the selection rectangle used to select a group of shapes within the 
Shape view has been enhanced.  If the selection rectangle is specified by dragging the 
cursor from left to right, only the shapes contained entirely within the rectangle will be 
selected.  However, if the selection rectangle is defined by dragging the mouse from 
right to left, all shapes contained within or intersecting the selection rectangle will be 
selected. 
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Space Gass Sections Libraries 

Space Gass Section Library files (*.slb) can now be imported into Section Maker via the 
command in the File->Import menu.  
 

Microstran Files 

Microstran Section Library files (*.asw) can now be imported into Section Maker via the 
command in the File->Import menu.  
 
 
 

Problems Fixed  

This version fixes the following problems experienced with previous versions of 
Multiframe, Steel Designer or Section Maker. 

 
• DXF entities defined in object coordinate systems are now imported correctly. 

• SDNF files with comments at the start of file are now recognised correctly. 

• Potential crash when reading SDNF files has been fixed. 

• Joint reactions were not loaded from a saved file in some cases, this has been 
fixed. 

• Opening frames generated on Macintosh computers now correctly imports joint 
linking data. 

• A file saved with no load cases could not be read into Multiframe, this has been 
fixed. 

• The Compute method of the Section object in Multiframe Automation now stores 
the mass correctly. 

• Combo boxes in Group Info and New Section dialogs did not select correct item. 

• The Compute method of the Section object in Multiframe Automation now 
computes the shear areas correctly. 

• Generation of lateral restraints did not work as expected. 

• Crash when opening Constraints tab of Member Properties dialog. 

• Numerous bugs in Space Gass and Microstran file formats. 

• Incorrect calculation of member displacements from non-linear analysis. This only 
occurred in members that met a specific criterion. 

• Incorrect calculation of member displacements in p-delta analyses of members 
with a pinned/rigid member release applied for bending about either axis. 

• Potential crash when viewing Design Constraints tab of Member Properties dialog. 

• Automation function for flipping section orientation for design members did not 
work. 

• Black and white rendering of I beams now renders edges correctly 

• A problem placing tubes in Section maker has been fixed. 
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Problem Reports 

We greatly appreciate any bug reports or suggestions we receive, please keep them 
coming.  Please continue to report any bugs or anomalies you find: 
 
Fax:  +61 8 9335 1526  Email: support@formsys.com 
 
You can also lodge your problem reports via our web site at the following location: 
http://www.formsys.com/Multiframe/MFSupport/MFProblemReport.html 
 
When emailing reports, please attach the frame and sections library with your message. 


